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Capture

Your StudioLive™ AR USB-series mixer comes with a powerful recording software
library that includes both Capture™ and Studio One® Artist. Designed exclusively
for StudioLive™ mixers, Capture™ multitrack recording software allows instant
setup and one-click recording at up to 96 kHz directly from the mixer, with

no configuration. Studio One Artist provides as fast, flow-oriented, drag-and-
drop interface built by creative people for creative music production.

We encourage you to contact us with questions or comments regarding
this product. PreSonus Audio Electronics is committed to constant
product improvement, and we value your suggestions highly. We believe
the best way to achieve our goal of constant product improvement is by
listening to the real experts: our valued customers. We appreciate the
support you have shown us through the purchase of this product.

About This Manual

We suggest that you use this manual to familiarize yourself with the features
and correct connection procedures for your StudioLive AR USB mixer
Software Library before trying to connect your Live mixer to your computer.
This will help you avoid problems during installation and setup.

Throughout this manual you will find Power User Tips. These tips provide
useful hints on how to best use the StudioLive AR-series Software Library
and take advantage of unique workflow functions and features.
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Technical Support

Many technical issues can arise when using a standard computer as a digital
audio workstation (DAW). PreSonus can only provide support for issues that
directly relate to the StudioLive AR USB mixer, Capture, and Studio One.

PreSonus does not provide support for computer hardware, iOS hardware, wireless
networks, operating systems, and non-PreSonus hardware and software, and it may
be necessary to contact the manufacturer of these products for technical support.

Please check our Web site (www.presonus.com) regularly for
software information and updates, firmware updates, and
support documentation for frequently asked questions.

Online technical support is available at www.presonus.
com/support/Contact-Technical-Support.

Advanced troubleshooting guides can be found at support.presonus.com/forums.

Summary StudioLive AR-series Software Library Features

Capture

Included with StudioLive is Capture, a digital-audio multitrack-recording application
designed to make recording quick and easy. Perfect for live recording and for mixing
your audio in real time to a stereo audio file, Capture was designed to interface
perfectly with StudioLive-series mixers, allowing instant setup and recording.

Capture allows you to record a single stereo track from the StudioLive’s main output,
one pair of subgroup outputs, or a pair of aux sends, in addition to all input channels.
This enables you to record the main mix or create a separate recording mix.

o Multitrack recording application (unlimited input
channels plus stereo stream from StudioLive)
e One-click recording with Record Now button
o Prerecord captures audio up to a minute before you press Record
e Auto-Save at user-definable intervals
o Automatic session and file recovery if the power fails
e Sessions store metadata, enabling automatic session naming
o Session Lock feature prevents accidental keyboard access
« Essential editing suite (copy, cut, paste, splice, resize)
o Big Meter mode turns your monitor into a gigantic meter bridge
o Stereo Playback mode—use Capture with any computer sound card
o Peak LED-style meter bridge with clip indicators
o Marker placement and recall
o Marker List with Quick Locate
o Export between markers
o Record stereo mix from StudioLive AR USB mixer
o Full transport control
e Import/export individual WAV, AIFF, or OpenTL
o Compatible with Mac® and Windows®
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1.4.2 Studio One Artist

All PreSonus audio interfaces include PreSonus Studio One Artist recording
software, which comes with over 6 GB of plug-ins, loops, and samples, giving
you everything you need for music recording and production. The Studio
One Artist Quick Start Guide is located in Section 4 of this manual. You will
find a complete user manual on the Studio One Artist installation DVD.

Unlimited track count, inserts, sends, and plug-in instantiations

20 high-quality PreSonus Native Effects™ plug-ins, in eight categories:

amp modeling (Ampire XT), delay (Analog Delay, Beat Delay), distortion
(RedLight Dist™), dynamics processing (Channel Strip, Compressor, Gate,
Expander, Limiter, Tricomp™), equalizer (Channel Strip, Pro EQ), modulation
(Autofilter, Chorus, Flange, Phaser, X-Trem), reverb (Mixverb™, Room Reverb),
and utility (Binaural Pan, Mixtool, Phase Meter, Spectrum Meter, Tuner)

Four high-quality PreSonus virtual instruments, including: Presence™
sample player, Impact™ drum machine, SampleOne™ sampler,
and Mojito analog-modeled subtractive synthesizer

Over 6 GB of loops, samples, and instruments

Open Capture 2 files natively

Innovative and intuitive MIDI mapping

Powerful drag-and-drop functionality for faster workflow
Mac OS X® and Windows® compatible
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p) Connecting to a Computer

Connecting your StudioLive AR USB mixer to your computer is quick and
easy. For Mac users, just connect your mixer to a free USB connection on your
computer and you're ready to go. For Windows users, you must first install
Universal Control. This will install both the ASIO/WDM driver and the control
panel for your StudioLive AR USB-series mixers. We made this installer as
simple and easy to follow as possible, and it will take you through each step
of the installation process. Please read each message carefully to ensure the
StudioLive driver and the control panel are properly installed. In particular, be
careful not to connect your StudioLive mixer to the computer too soon.

Please visit www.presonus.com for the latest system requirements
and an updated list of compatible hardware. It is also recommend
that you check your recording software’s system requirements.

Power User Tip: The speed of your processor, amount of RAM, and
capacity, size, and speed of your hard drives will greatly affect the overall
performance of your recording system. A faster processor and more RAM
can reduce signal latency (delay) and improve overall performance.

2.1 Installation for Windows

Before beginning the installation setup, please quit all applications, including
antivirus software, and disconnect the StudioLive mixer from your computer.

=T Follow the onscreen instructions to complete the installation. When the
Wk b e B e installer has finished, it will prompt you to reboot your computer.

This sl instad Freonus Unieersal Contal L o pour
oLt

conruing.
ik Mt 10 contmue, or Cancel b et Sk,

- Click “Finish” to automatically restart your PC. Once your computer has
El i Ml rebooted, connect the StudiolLive. When the Found New Hardware
wizard launches, follow the “Recommended” steps.

Your StudioLive is now synced to your computer and ready to use!
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2.1.1 Universal Control (Windows only)

UNIVERSAL CONTROL

StudioLive AR16 USB

Sample Rate

Clock Source

Block Size Auto
Safe Mode Reliable

Output Format

Loopback

Sample Rate. Changes the sample rate.

You can set the sample rate to 44.1, 48, 88.2, or 96 kHz. A higher sample
rate will increase the fidelity of the recording but will increase the file size
and the amount of system resources necessary to process the audio.

Safe Mode. Adjusts the Input Buffer Size.

These modes allow you to adjust the input buffer size
to optimize performance for your computer.

When adjusting the safe mode, the block size will be adjusted
automatically to provide the best performance.

Block Size. Sets the buffer size.

From this menu, you can set the buffer size from 16 to 4,096 samples (Mac), or 64
to 8192 samples (Windows). Lowering the buffer size will lower latency; however,
this will also increase performance demands on your computer. In general, you will
want to set the buffer size as low as your system can safely support. If you begin

to hear pops, clicks, or distortion in your audio path, try raising the buffer size.

Note: When adjusting the block size, the Safe Mode will
automatically change to provide the best performance.

2.1.2 Loopback Recording (Windows only)

The windows drivers for the StudioLive AR-series mixers provide two virtual
streams that allow you to record the output of on audio application in
another application. Loopback can be useful in a variety of situations:

o Recording the audio from a video game or YouTube
video for a podcast or livestream.

o Recording a vocal in real time over a karaoke track
played from a web browser or media player.

Power User Tip: Because the StudioLive AR-series mixers are class compliant Core
Audio devices, these virtual streams are not available in macOS. However, there
are several third-party applications that provide this functionality in macOS.
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From Universal Control, you can enable or disable Loopback and pick
the streams on which the loopback audio will be recorded.

When Loopback is enabled and “Merge Loopback with 1/2”is selected,
the audio from another application will be recorded with the audio source
connected to analog inputs 1 and 2 on your StudioLive AR-series mixer.

When Loopback is enabled and “Dedicated Loopback Inputs”is selected,
the audio from another application will be recorded on the last pair of
driver inputs (AR8:9/10, AR12: 15/16, AR16: 19/20, AR22: 23/24).

@
(= ]

(B

@

Media Player
Web Browser
Etc.

Power User Tip: When using either option, you will need to select Outputs 1 and
2 in the audio application your want to record. Make sure to select Outputs 3 and
4 in the audio application in which your recording to avoid a feedback loop.
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2.1.3 Using the StudioLive for System Sound

Click on the small speaker icon in the bottom right corner
of the screen and select “Playback Devices.”

Open Volume Mixer
Playback devices

Recording devices

Sounds

Volume control options
10:27 AM
1/13/2011

o (Wl )

Select StudioLive AR playback channels 1/2. This will route your
system audio to the USB return on the Super Channel of your mixer.
Select“Set Default” at the bottom of the screen and click OK.

" Sound e
Playback Recording Sounds Communications

Select a playback device below to madify its settings:
SL-AR12 Playback 1/2 2

& 2- Studiolive 4R12

- Default Device

SL-AR12 Playback 3/4

_‘@ 2. StudioLive AR12
Ready
AMD HDMI Cutput
AMD High Definition Audio Device
Mot plugged in
Speakers
Generic USE Audio Device
Ready
Speakers
High Drefinition Audio Device
Mot plugged in

o juk
Canfigura Set Default E’*’ Properties

Now that your StudioLive AR-series mixer is setup as the default playback
device for your computer’s operating system you can use it for basic playback
from your computer via your media player or from your Internet browser.

To playback system audio from your computer through your mixer, press the USB/SD
Card Return button on the Super Channel and make sure it is in the down position.

f [ 90

11/12 |ST13/14)

STUDIOLIVE AR

A% Pre

USBISD Card
Retum
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2.2 Installation for macOS
The StudioLive AR USB mixers are class compliant audio devices in macOS. No
installation is required. Just connect your mixer to a free USB connection
2.2.1 Using the StudioLive for System Sound

You can configure your StudioLive AR-series mixer as the audio interface for computer
system audio (for iTune playback, Skype, etc.) from the System Preferences menu.

1. Open System Preferences

l.’ Finder File Edit View Go Window Help
About This Mac

System Preferences...
Location
App Store...

Recent Items

2. Open your System Sound Preferences

3. Select your StudioLive AR-series mixer from the Outputs
list. If you would like to use your StudioLive mixer for
System input, select it from the inputs tab as well.

[ £ tHH Sound Q

Sound Effects Input

Select a device for sound output:
Name Type
Display Audio UsB

StudiolLive AR16

Settings for the selected device:

The selected device has no output controls

Output volume: B . ' ‘))) Mute

Show veolume in menu bar

(T om0 Tz [sriand] To playback system audio from your computer through your mixer, press the USB/SD
P N STUDIOLIVE AR s .
) 1) [T | 7= Card Return button on the Super Channel and make sure it is in the down position.

U5 Pre

24 Bit196kHz

Return
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2.3 Using the StudioLive with Popular Audio Applications

Steinberg Cubase 4+

Ableton Live 5+

Below are basic driver-setup instructions for several popular audio
applications. Complete setup instructions for PreSonus Studio One Artist
and a brief tutorial on its features are located in Section 4 of this manual.

Launch Cubase.

Go to Devices | Device Setup.

Select “VST Audio System” from the Devices column in the Device Setup.
Select PreSonus FireStudio from the ASIO Driver dropdown list.

Click “Switch” to begin using the StudioLive Driver.

Once you have successfully changed the driver, go to Devices |
VST Connections to enable your input and output buses.

Launch Ableton Live.

Go to Options | Preferences | Audio.

Choose Driver Type: ASIO | Audio Device: ASIO PreSonus StudioLive AR
Go to Input Config : Enable and select the desired Input channels.

Go to Output Config : Enable and select the desired Output channels.

You may now select the StudioLive’s inputs and
outputs for each track created in Live.

Apple Logic Pro/Express 7+:

1.

2.

Launch Logic Pro/Express.

Go to Logic | Preferences | Audio.

Click on the Devices Tab.

On the Core Audio tab, check Enabled.

Select PreSonus StudioLive AR from the device menu.

You will be asked if you'd like to relaunch Logic. Click “try (re)launch!”

Your StudioLive features custom I/O labels for faster work flow. To enable
these labels for use in Logic, go to Options | Audio | I/O Labels.

The second column in the pop-up window will be named
“Provided by Driver.” Activate each of these labels for your
StudioLive. When you are done, close this window.

You are now ready to use your StudiolLive.
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Pro Tools 9+

Cakewalk Sonar 6+

24

24.1

1. Launch Pro Tools.

2. Got to Setup | Hardware and select PreSonus StudioLive
AR from the Peripherals list. Click OK.

3. Go to Setup | Playback Engine and select PreSonus FireStudio
from the menu at the top of the window. Click OK.

1. Launch Sonar.

2. Go to Options | Audio... and click on the Advanced tab.

3. Change the Driver Mode to “ASIO!"

4. Click the “OK"button.

5. Restart Sonar.

6. Go to Options | Audio... and click on the Drivers tab.

7. Highlight all input and output drivers beginning with “PreSonus StudioLive AR
8. Go to Options | Audio... and click on the General tab.

9. Setthe Playback Timing Master to “PreSonus StudioLive AR ... DAW Out 1"

10. Set the Recording Timing Master to “PreSonus StudioLive AR ... Mic/Inst 1”

Digital Sends and Returns

Digital Sends

USB Send

[

When using the StudioLive as an audio interface, it is important to
understand the terms “digital send” and “digital return.” Because the

audio interface in the StudioLive is completely integrated with the other
functions of the mixer, the USB I/O is designed to work as an independent
bus. You can route (send) signals from other buses to the USB bus, and its
output (return) signal is hard-coded to designated mixer channels.

The StudioLive AR8 USB has 8 available sends and 4 returns.

The StudioLive AR12 USB has 14 available sends and 4 returns.
The StudioLive AR16 USB has 18 available sends and 4 returns.
The StudioLive AR22 USB has 22 available sends and 4 returns.

Each Mono and Stereo channel on the StudioLive AR-series mixer has its own digital
send. This allows you to record every channel input on its own track in Capture,
Studio One Artist, or your favorite Core Audio and ASIO audio application.

The Main bus also features its own digital send on the final pair of digital
sends (ARS8: 7/8, AR12: 11/12, AR16: 15/16, and AR22: 21/22).

Note: In Windows, these sends are the second to the last pair. The last pair of driver
inputs are reserved for loopback functionality. See Section 2.1.2 for more information.

The Main bus can also be recorded on the first two digital sends by engaging the USB
send 1/2 button on your StudioLive AR-series mixer. When this button is engaged,
Channels 1 and 2 cannot be recorded independently, but they will be recorded as
part of the Main Mix. This is a great option for recording rehearsals and podcasts.

10
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2.4.2 Digital Returns

15/16 (ST17/18

USB/SD Card
Return

SD Card ML

StudioLive™ AR-Series Software
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The last two stereo channels on the StudioLive AR mixers are hard-coded
to receive two stereo digital returns. Digital returns 1/2 are available on
the Super Channel, Digital returns 3/4 are routed to the last stereo
channel (AR8: 7/8, AR12: 11/12, AR16: 15/16, and AR22: 21/22). Outputs 1
through 4 in your recording application route these playback streams to
these channels on the StudioLive (that is, the software’s Outputs 1/2
always go to StudioLive AR Super Channel and Output 3/4 always go to
the last stereo channel). Once you route a track in your recording
application to play through one of these outputs, it will always be
accessible on its channel by simply pressing the Digital Return button.

Power User Tip: It is important to think of your digital returns and your analog inputs in
the same way. When a digital return is engaged, it replaces the analog input in the mix.

1
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T I e (N (TIMIENT

PreSonus® Capture™ 2.0 is a multitrack digital-audio recording application designed
to make recording with StudioLive™ mixers quick and easy. With the look and feel of
a digital multitrack hard-disk recorder, it is instantly familiar. It uses the same high-
quality audio engine as PreSonus’ groundbreaking Studio One® DAW, and its Session
files can be opened directly in Studio One—no conversion or exporting required.

Capture 2 was designed exclusively for StudioLive-series mixers,
allowing instant setup and recording directly from the mixer, with
no configuration. Just launch Capture 2 and click Record Now. At
the end of the show, click Stop, save the file, and you're done!

3.1 Installation Instructions

3.1.1 macOS

Installing Capture 2 on macOS machines is as simple as drag-and-drop.

1. Double-click on the Capture .dmg file.

PreSonus

&co  refonus Eagure2 2. Drag the Capture 2 icon to the Applications folder shortcut.

12
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. 3. Once Capture has been copied to your hard drive, it is ready to use. Simply

- = 00 e |- 8- |2~ » B H i i
— open your Application folder and double-click on the Capture 2 icon.

£# Dropbox "

sl dotrreeni| ]

= Desktop ;

[# Documents E

3 Downloads Phots B &b FreSonus Capiure

B Mavies Zapy

Jo Music

3.1.2 Windows

The Windows installer for Capture 2 was designed with easy-to-follow
onscreen instructions to make the installation process quick and simple.

1. When you launch the Capture.exe file, a Welcome Screen will launch. If you haven't
ot G already done so, close all other open applications before clicking “Next.”

Before Capture 2 can be installed on your computer, you must first agree to the
licensing terms. Click“l agree.”

£ AAIVENT
L)

S s Ekcirone, ., TEIT P v, ek g, LS 0000
4 R
1T L oy o ozl e
Tk i o,
Elethorias, K. Puscan s £ poge e
g arcl s edaciah

e (Torms e 7
e

sreamart o il P Capkrn 2

By default, Capture 2 will install in the Program Files folder on your computer. It is
highly recommended that you do not change this default location. Click “Install””

=== 4. Once Capture 2 has been successfully installed on your computer, you can click

i e G “Finish” to exit the install wizard. You're ready to start recording!

PraCaras Caphs & has base sl o o g,

CickPronh .2 rd
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3.2  Start Page

You will be taken to the Start page when Capture 2 is launched. The Start page allows
you to create a new Session, open a Session stored on your computer, view recent
Sessions, and verify that your StudioLive is properly communicating with its driver. In
addition, you can begin recording instantly by just clicking the Record Now button.

3.2.1 Tagging and Organizing a Session

At the top of the Start page, you will find the three Name Scheme
fields: Artist, Performance, and Location. By entering information into
each of these fields, your Session will be automatically named with this
information, in this order, and tagged with the same helpful metadata.

These tags also help to keep your files organized. Rather than throwing
every Session into a single folder, all tagged Sessions will automatically
be put into an organized folder hierarchy. By default, Capture 2 inserts
the date of performance and creates subfolders. These options can

be changed in the Options menu, see Section 3.2.5 for details.

By default, the folder tree is Artist/Performance/Location. This
structure is useful for regularly gigging bands that want to archive
performances (e.g., Artist: PreSonus All Stars, Performance: Winter
Tour 2017, Location: Baton Rouge — Manship Theatre). However,
Capture 2 doesn't limit you to this folder structure. You can change the folder
hierarchy from the Options menu. Here are other available Name Schemes:

o Location/Artist/Performance. This Name Scheme is especially useful
for venue owners who are archiving the performances on their stage
(e.g., Location: Manship Theatre/PreSonus All Stars/Winter Tour 2017.

» Location/Performance/Artist. Use this Name Scheme when recording
an entire festival (e.g., PreSonuSphere/Stage 1/PreSonus All Stars).

As you archive your performances, Capture 2 stores a history of the names you have
— entered into each field. To use a name again, simply click on the pull-down menu for
e Honker that field and select it from the list.

Phatt Hat
Hadji

To clear the currently selected name from the list, select Remove First from the
pull-down menu.

Remove First
Clear History dp

To remove every name in the list, select Clear History. Once the history has been
cleared, it cannot be undone, so be certain before you choose this option.

Nadia
Fat Rocker
Phatt Hat
Hadji

Remove First
Clear History

14
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3.2.2 Creating a Session

Below the Name Scheme fields, you will find the New Session button. Click on the
New Session button to create an empty Session.

Power User Tip: A Session is a Capture 2 file in which you record, arrange,
and edit your audio files. Session files should not be confused with audio
files. Think of a Capture 2 Session as you would a StudioLive scene. It is a
snapshot of which audio files were recorded and how they were edited.

You can also create a new Session by doing one of the following:

[ # Capture m_Edit Session Help

» Navigate to File/New Session.

Recent Files

e 0o New Session...
Open Session...

o Press [Ctrl]/[Cmd]+N on the keyboard.

If you have filled in the Name Scheme fields, your
new Session will launch automatically.

If you have not filled in these fields, a setup menu will open.

New Session

New Session

2013-03-12 Recording

{Users/Ell-D/Documents/Capture

» Session Title. This will be the title of your Session and will be the Session filename,
as well as the name of the new folder that contains all data related to your Session.

» Session Folder. This is where new Sessions and all related data will be saved.
The Session location can be chosen each time you create a Session. By default,
the new Session location will be the Capture 2 folder in your Documents folder.

You can choose a different file location by clicking on the Browse button and
browsing to a new location. The last known save location will appear as the default
the next time you create a new Session.

Power User Tip: The Name Scheme fields have been added to Capture 2
to help keep your Sessions organized and to make your archived library
of live performances more easily searchable. Because of this, we highly
recommend that you always take a moment to fill in these fields.

15
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Record Now! Clicking the Record Now button on the Start page will launch a new
Session, arm all tracks for recording, and begin recording immediately. If you do not
have any of the Name Scheme fields customized, your Session will be labeled with
today’s date.

3.2.3 Open aSession

Open Session Button

Recent Files List

- 1602 Demo Session

©  Justin Rocks - 2013-01-15 - World Tour 2013
© Justin Rocks - World Tour 2013 - 2013-01-15 - London

The Capture 2 Start page provides two different
ways to quickly open previous Sessions.

Clicking on the Open Session button will open a browser that will allow you to
browse for, and open, an existing Session.

Located below the Open Session button, you will find the Recent
Files list. This list includes links to the most recently opened
documents. Click on any of these links to quickly open the
Session.

° Jazz Fest 2013 - Justin Rocks - 2013-01-15 - Stage 2 Thurs

*  Hadji - Test 1 - 2013-01-14 - My Desk

" 2013-01-14 Recording

° Hadji Recording

Locate Missing Files

( 8 Capture File Edit JFTS5000 Help
Import File...
Export Tracks...
Locate Missing Files...

Start

Record *
Stop 0
Return to Zero 5
Locate End E
Loop Active /

oop Selectior >
Locate Selection L

Insert Marker
Locate Next Marker N
Locate Previous Marker B

In the event that the Session you open is missing audio files, Capture
will help you find them. Use Session>Locate Missing Files to search your
computer for lost resources.

3.24 Audio Device and Sample Rate

Capture 2 was created for use with PreSonus StudioLive-series mixers and fully
functions only with that device. The Audio Device menu displays the currently
selected audio driver. When a StudioLive AR Mixer is connected, you should
select “PreSonus StudioLive AR22/16/12/8" from the Audio Device list.

StudioLive AR16 44.1 kHz

W

If the currently selected audio device has exactly two outputs (as with the built-
in audio card in a Mac), Capture goes into Stereo mode. While in Stereo mode,
Capture connects all tracks to the stereo output and adjusts the volume of the
output automatically to account for stereo summing. Stereo mode enables you
to listen to Sessions while away from your StudioLive. Unless the StudioLive's
driver is selected, you cannot create a new Session or record new audio.

The Sample Rate menu displays the currently configured sample rate.

16
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3.2.5 Options Menu

: The Options button can be found just above the bottom of the Start page. This
Options launches the Options menu.

{5 PreSonus

Capture This menu can also be accessed from Capture>Options.
: About Capture

Options... o

Services >

Hide #H
Hide Others X #H

Quit Capture ®0Q

It can also be accessed by clicking on the Options button on the Session page.

12:48:30 12:48:31 (FRTEFE Options [Commands.]

The Options menu provides all the tools necessary
to configure your Session preferences.

Audio Options

Audio

StudioLive AR16
512 samples

44.1 kHz

24 Bit Wave

Ssec

¢ Audio Device. At the top of the Audio Options, you will find
the Audio Device menu. This is the same menu that is on
the Start page. See Section 3.2.4 for information.

o Device Block Size. This displays the buffer size. In general, the higher the
buffer size is set, the more stable your recording environment will be.

o Sample Rate. The Sample Rate menu is also found on the
Start page. See Section 3.2.4 for information.

¢ Record Format. The Record Format menu allows you to
choose the bit-depth of the recorded audio. You can select 16-
bit WAV, 24-bit WAV, or 32-bit floating-point WAV.

Power User Tip: The higher the bit-depth of your audio, the better its resolution, and
the bigger the resulting file size will be. In general, we recommend recording at 24-bit.

o Pre-Record. Capture 2 allows you to set a Pre-Record buffer. This
buffer starts recording audio before your click the Record button so
you won't miss the beginning of a performance. The Pre-Record buffer
time is user-selectable, between five seconds and one minute.

Power User Tip: The higher the Pre-Record buffer is set, the more RAM Capture 2 will
require. While this will not cause problems on modern systems that are equipped with
copious amounts of RAM, it is highly recommended that the Pre-Record buffer be set
as low as possible on systems with the minimum amount of required RAM (2 GB).
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Timeline Sync

Sync To Computer Time

Timeline Sync Mode. Capture 2 features a Timeline Sync mode. This
allows you to align the timeline in your recording Session to the time of
day or to sync it to an external MIDI Time Code signal. This will also affect
the timestamp information, which is written into the audio files.

e No sync. The timeline will start at 0 and will display the length of
your recording (in minutes and seconds only). This option is useful
when you only want to track the length of your recording.

e Syncto computer time. The timeline ruler will start at the exact time of
day the recording began. This option is useful when recording multiple
performances over the course of a day (e.g., at a festival stage).

e Syncto MTC. Capture will align the timeline to incoming MIDI Time
Code. This option is useful when recording audio for a live video.

MIDI Time Code Input. To use the Sync to MTC option, you must provide Capture
with an input for the source time code. You can select that source from this menu.

File Handling

Change...

[Users/Eli-D/Documents/Capture

Artist - Performance - Location ~
Create Subfolders
Add Date To Path

As discussed in Section 3.2.1, Capture 2 provides an assortment
of useful tools to organize and label Capture Sessions.

Storage Location. By default, all Capture Sessions are stored in the
Capture subfolder in your Documents folder. You can set a new default
location by clicking on the “Change..." link. This will launch a browser
window, allowing you to find a new location for your Capture Sessions.

Name Scheme. Section 3.2.1 discusses the various options
for naming and organizing your files. This option enables you
to select the order in which your files are categorized.

Create Subfolders. Clicking the Create Subfolders options will
create a folder for each of the three naming conventions: Artist,
Performance, and Location. If this box is not checked, your Session
and the resulting audio files will still be labeled using these tags but a
folder hierarchy will not be created. This box is enabled by default.

Add Date to Path. By default, Capture automatically adds the date of the Session
to the Session name. You can remove the date by unchecking this option.
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3.3 The Session Page

Capture 2 features a single-window user interface so you don’t need to
manage multiple windows and views. When a new Session is created, or an
existing Session is opened, you will be taken to the Session page. This page
contains all of the necessary tools to record and edit multitrack audio.

When you launch Capture 2, a recording track is created for each input
channel on your StudioLive AR mixer, including the Main bus. The Main
bus track, in turn, is automatically patched to the first two digital returns
located on the Super Channel on your StudioLive AR mixer for playback.
Channels 1 and 2 are routed to the Digital Returns 3/4 on the last stereo
channel. The following diagrams show these configurations.

Capture 2 Recording Routing

] 1] | ) | 1) T T T t=

eiloilollellelieiloilo]lo) ™ K

N
 Hommnma

Capture 2 Playback Routing

OO
LECEE @ @ @6 6 & 6 @
000000000
NN NN NN
There is no need to set up audio inputs and outputs in Capture 2, as the
software automatically detects which StudioLive model is connected
and auto-configures for it. Each channel from the StudioLive AR mixer

is represented with a mono input track in the Track column of the
Session and has a corresponding level meter in the meter bridge.

An additional stereo track will also be added to the
Session for recording the main mix.

Power User Tip: Unlike a DAW application, like Studio One Artist, Capture has

no mix engine of its own, relying, instead, on the physical mixer connected to

it to do the mixing and the summing. Because of this, once you're ready to mix
your recordings, you will need to move you audio over to your favorite DAW
application. If your favorite DAW is Studio One, you can simply open your Capture
session from the Studio One Start page. See Section 3.6.2 for details.
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3.3.1 Track Column

Along the left side of the Session page, you will find the Track column. The Track
column contains a dedicated audio track for each audio input into Capture 2 from the
StudioLive AR mixer, plus a stereo audio track to record the main mix.

Track Naming.

kicd LS To name a track, double-click on the default name to open a text-
edit box. Enter the name you would like to use and hit Enter.

There are several benefits to giving each track in your Session a name. First,
it allows you to know at a glance what is being recording where. Second, if
you name your tracks before you begin recording, the audio file recorded
on your named track will be given the same name. So, for example, instead
of a bass line being recorded as Track 15, it would be recorded as Bass.

Power User Tip: As with Studio One, you can press the Tab
key to move to the next track’s name field.

Arm All.
m In the upper left-hand corner, you will find the Arm All button. Click this button to
arm (enable) all inputs for recording.
Track Controls.
1 Kick Ml Each track in the Track column features the same controls.

Record Arm Button. Next to each track number is the Record Arm button. When
this button is active, Capture 2 is ready to record audio that is routed to the track.

Power User Tip: The track number to the left of each track in the list corresponds
directly to the same channel number on your StudioLive AR mixer.

Track Mute. Each track features a Mute button. This mutes the track during playback.

Track Solo. Each track features a Solo button. This will solo the track and mute
all other tracks during playback (similar to the SIP function on the StudioLive).

3.3.2 Transport

The Transport is located in the top left corner of the
Session page. It contains all the functions you need to
navigate through your Session.

E Stop. Stops playback.

ﬁ Play. Starts playback at the current playback-cursor position.
- Record. Starts recording at the current playback-cursor position.
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Session Lock. The Record Lock button prevents the recording from accidentally
being stopped by an errant press of the space bar. Session Lock is automatically
enabled when Capture starts recording. It can be defeated by simply clicking on it.

Power User Tip: Markers can still be edited and dropped while Session Lock is enabled.

Return to Zero. Returns the playback cursor to the beginning of the Session.
Previous Marker. Jumps the playback cursor to the previous marker.
Rewind. Rewinds as long as this button is enabled.

Fast Forward. Fast-forwards as long as this button is enabled.

Next Marker. Jumps the playback cursor to the next marker.

Go To End. Jumps the playback cursor to the end of the recorded audio.

BEFEEE B

Loop. Engages/disengages Loop mode. See Section 3.3.6.6 for more information.

o

3.3.3 Time Display

Fat Rocker Live after 5

00:00:00 00:01:08 1:02days

Record Duration Current Position Remaining Time

The Time Display provides you with critical information about your recording.
Session Name. Displays the name of the current Session.

Record Duration. Displays how long the current Session has been recording.
Cursor Time. Displays the current timeline position of the playback cursor.

Remaining Time. Displays the remaining time that can be recorded, based on the
size of the available storage left on the hard drive to which you are recording.

3.34 Timeline Ruler

Ao eeime lee i Sl

At the top of the Session Editor, you will find the Timeline
Ruler. This displays time increments in seconds.

As mentioned in Section 3.2.5, you can set the Timeline Ruler to sync to
your computer’s clock or to an external MIDI Time Code source.

3.3.5 Navigating the Session

Zooming

You can zoom in and out of your Session, with respect to time, in the Session
Edit window, so that you can look at the entire length of the Session or

just view a small region of time to make accurate edits. You can also zoom

in and out with respect to the size of the audio files in your Session.

To zoom, do one of the following:

o Tozoom in or out, click-and-drag left or right on the Horizontal Zoom scroll bar in
the lower right-hand corner of the Edit window.

e Press [Ctrl]/[Cmd]+[+] on the keyboard to zoom in slightly. Press
[Ctrl]/[Cmd]+[-] on the keyboard to zoom out slightly.
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o Click inside the Timeline Ruler at any point in time

and drag down or up to zoom in or out.

e Inthe lower left-hand corner of the Edit window, you will find the vertical-zoom
controls. These controls increase or decrease the height of the tracks and
audio files.

To scroll left and right through time in your Session, click-and-drag
the horizontal scroll bar near the bottom of the Edit window.

You can also scroll through your Session by clicking and
dragging the Timeline Ruler left or right.

_®& Capture File Edit [T Help

800 | Import File... Il
Export Tracks... %E
Locate Missing Files...

Record %
Stop 0
Return to Zero 5
Locate End E
v Loop Active i
Loop Selection P
Locate Selection =

Overheads

Insert Marker
Locate Next Marker N
Locate Previous Marker B

tnable Soundcheck

To jump the playback cursor to the beginning of any audio event,
press L on the keyboard or select Session>Locate Selection.

In the upper right corner, you will see four editing-tool buttons. These
tools will determine the function of your mouse during editing.

Power User Tip: The audio-editing process can be unforgiving. Small inaccuracies when
splitting, moving, or performing other actions on recorded audio can lead to unwanted
results. As simple as it may seem, the act of listening while editing is often overlooked.
For instance, when sizing the edges of a vocal part to remove unwanted sounds
between words, it is tempting to make the edits based on the visual representation of
the waveform. While this may work sometimes, it is much better to listen as you size

the events to be sure you are not removing any critical part of the vocals. Listening

to your edits as you make them will save time and frustration in nearly every case.
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This is the default tool for access to most functions. Click on the Arrow tool button or
press [number 1] on the keyboard to select the Arrow tool.

The Arrow tool can be used for the following purposes:

To move an audio event using the Arrow tool, click anywhere on the event and
drag left, right, up, or down. Dragging the event left or right will move the event
backward or forward in time. When dragging an event left or right beyond the
viewable arrangement, hold [Space Bar] on the keyboard to speed up the scrolling.

0n00:05.392
Dragging the event up or down will move the event to another track.
When dragging an event from one track to another (up or down), the
position of the event will be constrained within an automatic snapping

range to make it easy to keep the event at the same time position. To
defeat this snapping, hold Shift while dragging the event up or down.

To rearrange tracks using the Arrow tool, click on the track you want to move and
drag up or down in the Tracks list. You will notice a blue line following your mouse.
When you drop the track, it will be inserted where the blue line is located.
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3.3.6.2 Range Tool
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Events can be thought of as windows into audio files and musical performances,
where what you see is what you hear. You can resize events to make them shorter
or longer so that only a portion of the audio or musical data is seen and heard.

To size any event using the Arrow tool, float the mouse to the left or right edge of the
event to reveal the Sizing tool. When this tool appears, click-and-drag left or right to
size the event. Events can be sized and resized nondestructively any number of times.

0:03:38.320 | Lenath: 2:18.769 min

Multiple events can be selected in order to edit them all at once, with a single
action. To select multiple events with the Arrow tool, do one of the following:

o Click outside of the range of an event and then drag over any other
events; a gray box will be drawn while you drag over the target-selection
area. Release the mouse button once the box is drawn over all of the
events you wish to edit, and these events will be selected for editing.

o Click on any event; then, while holding [Shift] on the keyboard, click on any other
events to select them. This allows you to select multiple events that are not in
close proximity to each other. All selected events can then be edited at once.

The Range tool is used to select a range, or area, within events. Click on the Range
tool button or press [number 2] on the keyboard to select the Range tool.

2:02.088 - 2:29 464 (27.376)

To select a range within an event, using the Range tool, click-and-drag over the area
to be selected; a gray box will be drawn over the target selection area.
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Release the mouse button when the box is drawn over the
range of the events you wish to select. The range you have
selected is now treated as a single, consolidated event.

The Range tool can be useful in several ways:

o You can use the Range tool to select the content of several audio events
across multiple tracks for a specific portion of a song (say, an amazing
drum groove) and then use the Arrow tool to move that section of
audio to another section of a song (say, to replace a drum groove).

¢ Another common use of the Range tool is to quickly select and delete a
range of audio within an event, rather than using the Split tool to make
two splits, then select and delete the section with the Arrow tool.

Power User Tip: When you float the mouse cursor over a selected range, the Arrow tool
will temporarily appear. This makes it easy to quickly select and edit a range of events.

To select multiple, discontiguous ranges across any event, on any track, hold the
[Shift] key while using the Range tool. Continue to hold [Shift] and use the Arrow
tool to select whole events. For instance, when using the Arrow tool, if you press
and hold [Ctrl], you get the Range tool. Press and hold [Ctrl] and [Shift] to select
multiple ranges, then continue to hold [Shift] but release [Ctrl]; now you have the
Arrow tool and can select whole events. All of your selections will remain selected.

Selected ranges can be sized by floating the Range tool at the left/
right edge of the selection. You also can split a selected range at the left
and right edges of the selection by choosing Split Range from the Edit
menu or by pressing [Ctrl]/[Cmd]+[Alt]+[X] after selecting a range.

Using the Split tool, single events can be splitinto multiple events. Click on the Split
Tool button or press [number 3] on the keyboard to select the Split tool.

With the Split tool selected, a vertical and horizontal line will be drawn near the
current mouse-cursor position. The vertical line indicates the exact time position
of the Split tool, while the horizontal line underscores the track on which the event
to be split resides. The Split tool is directly affected by the current Snap settings.

Click on any event with the Split tool to split the event at that position.
By splitting a single event, you create two events that can be edited
independently. If multiple events are selected across multiple tracks,
the Split tool will affect all of the selected events in the same way.

Itis also possible to split selected events at the timeline cursor, without
using the Split tool, by pressing [Alt]+[X] on the keyboard.

The Eraser tool is used to delete an event. Click on the Eraser Tool button or press
[number 4] on the keyboard to select the Eraser tool. To delete any event using the
Eraser tool, simply click on the event. The Eraser tool is unaffected by the current
selection and will only affect the event that is directly clicked on.

However, if you click on a selected element with the Eraser
tool, all currently selected elements will be erased.

3.3.6.5 Common Editing Actions

Like most software applications, Capture 2 supports basic cut,
copy, and paste actions. Once you've selected an event, or a range
of events, you can perform these actions as follows:

e Cut: Press [Ctrl]]/[Cmd]+X on the keyboard to cut
the current selection or select Edit>Cut.

e Copy: Press [Ctrl]/[Cmd]+C on the keyboard to copy
the current selection or select Edit>Copy.
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Paste: Once a selection is cut or copied, press [Ctrl]/[Cmd]+V on the keyboard
to paste the selection or select Edit>Paste. The selection will be pasted to the
current playback-cursor position, or to the beginning of the track from which
the selection originated if the playback cursor is not currently set anywhere.

To loop the playback of any range of your Capture 2 Session, do one of the following:

Loop Selection. Select an event with the Arrow tool or select a range with
the Range tool. Go to Session>Loop Selection or press P on your keyboard.
This will create a loop the exact length of the selected audio event. The range
will be indicated by a bar drawn in the timeline, with flags at both ends.

(@ Capture File Edit JEETTT Help

800 Import File... 1
Export Tracks... ®E
Locate Missing Files...

Record 4

ark Rarord

Stop 0
Return to Zero
Locate End
v Loop Active
Loop Selection
Overhends Locate Selection

Insert Marker
Locate Next Marker N
Locate Previous Marker B

nable Soundcheck Fa

Custom Loop Range. To create a custom loop range, mouse over
the gray line above the timeline ruler. Notice that your cursor
changes to a Pencil tool, and you can draw your loop range.

15:29:15 15:29:20

p Once your loop range is set, you can click on the Loop button in the transport, or
- press [L] or [/] on the keyboard, to engage Loop mode.

Please Note: Engaging Record in the transport will disable Loop
mode and will begin recording at the current playback-cursor
position. It is not possible to engage Loop while recording.

3.3.6.7 Bounce Selection

Once you have edited an audio file, you may wish to create a new audio file
that includes all of your edits. To do this, use the Range tool to select the
events you would like to merge as described in Section 3.3.6.2 and press
[Ctrl]/[Cmd]+[B] on the keyboard or go to Edit>Bounce Selection.

@ Capture File m Session Help
800 Undo Split Event 382

Cut #;X
Copy #C
Paste F#\V
Delete

Select All HA
Deselect All #D

Bounce Selection , B

Zoom In ¥+

Overheads
Zoom Out £
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3.3.7 Meter Bridge

Capture 2 provides input and output metering
- l . l - l . 1 | . _— I I I I when a track is being recorded or played back.
These peak-style meters at the bottom of the
Session page feature clip indicators for each input
into Capture 2 from the StudioLive AR-series mixer.

5 & 0

| 2 4 5 & T a 8 1l
REC AEC REC REC REC REC REC REC RED AE

Record Arm.

Below each meter, you will find another Record Arm button. This button provides the
same functionality as the Record Arm button in the Track column. See Section 3.3.1
for more information.

Link Button.

Between each meter you will find a Link button. When this button is active, Capture 2
will record that track as a stereo-interleaved file. By default, the mix mix track is stereo
linked.

Big Meter Mode.

The Big Meter Mode button is located in the upper right
corner of the Session page, above the editing tools.

When this button is engaged, the lower three-quarters of the Session page
will display detailed metering for every track. While in this mode, the Marker
Lane, transport, mode buttons, and editing tools will still be visible.

3.3.8 Markers and the Marker List

The Marker Lane.

15:28:00 15:28:05 15:28:10 15:28:15

Marker + - rlim!l

The Marker Lane is located just below the Timeline Ruler.
It displays any markers you have created.

In Capture 2, the Marker Lane is used to place markers at desired
places in the timeline, after which navigation to the markers is easy.
Markers are also helpful when exporting your Session to individual
mixes or for editing in another recording application.

Power User Tip: We highly recommend that markers be inserted during the recording of a
live performance, as the markers will make the rest of the production process much easier.
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The Marker List.

The Marker List button is located above the editing tools on the right side
of the Session page. Clicking on the button will open the Marker List, which
provides an overview of every marker in your Session and offers an easier
way to quickly name markers and move them around your Session.

3.3.8.1 Inserting, Naming, Deleting, and Moving Markers

Marker Lane.
Adding/Deleting Markers. At the top of the Track column, you will see the Add/

Remove Marker buttons. To insert a new marker into the Marker Lane, with playback
running or stopped, click on the Add Marker (+) button, or press [Insert] on the
keyboard. Each new marker will be numbered sequentially by default (#1, #2, #3....).

Select a marker and click on the Remove Marker (-) button to remove the marker.

Edit Name Naming Markers. To rename a marker, double-click on the marker in the Marker
Lane, type in a new name, and then press [Enter] on the keyboard.

Edit Name

o

caron | oc ]

Moving Markers. To move a marker, click on it in the
Marker Lane and drag it to the desired location.

15:28:40

Marker List.
At the bottom of the Marker List, you will find three buttons.

Add Marker Move Marker Delete Marker

Adding Markers. Click on Add Marker to add a marker
at the current playback-cursor position.

Markers

Loc # Time Name

1 15:28:23 Verse 1

| A E R R 15t Chorus

When a Marker is added to the Marker List, the Name field
automatically becomes editable. Enter a new name and hit Enter.
This name can be edited later by double-clicking on it.

Moving Markers. Clicking on the Move Marker button will move the currently
selected marker in the Marker List to the current playback position in the timeline.

Deleting Markers. To remove a marker, select it in the
Marker List and click on the Delete Marker button.
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3.3.8.2 Navigating Markers

It is possible to quickly jump the playback cursor between markers in
the Marker Lane. Jumping to markers during playback allows quick
comparisons between different sections of your Session.

To navigate to a previous marker, do one of the following:

o Click on the Previous Marker button in the transport.

o Press [B] on the keyboard, to jump to the previous marker.

To navigate to the next marker, do one of the following:

o Click on the Next Marker button in the transport.

o Press [N] on the keyboard, to jump to the next marker.

To jump to any marker in your Session, open the Marker List and click on the
Location field. The playback cursor will jump to this location in the timeline.

3.4 Recording a Session in Capture

1

Setting Input Levels. Setting the proper input level is critical to making a good live
mix and a good recording. The basic idea is to set the input gain on the StudioLive
AR-series mixer as high as possible without overloading the input. Overloading

the input will cause clipping (digital distortion), which is particularly unpleasant
and will ruin the recording. This damage cannot be undone in software. There

is a clip indicator for each input on the StudioLive AR mixer for this purpose.

If an input channel is not clipping on your StudioLive AR-series mixer, you
can be sure that it will not clip in Capture 2. Refer to your StudioLive AR-
series Hardware Owner’s Manual for the proper level-setting procedure.

You will monitor live audio input on the StudioLive AR-series mixer; there is no
separate monitoring capability within Capture 2. Please refer to the StudioLive
AR-series Hardware Owner’s Manual for information on creating monitor mixes.

Arming Tracks. To record to an audio track, the track must be record-
enabled, or“armed.” Capture 2 provides two Record Enable buttons for
each input: one on the track and on the meter bridge. Once an audio

o ! .
- e track is record enabled, you are ready to record audio to that track.

Lo |
e
4]

Hit Record! To activate recording, click on the Record button in the transport. The
Record button will turn red, and the Play button will turn green. The playback cursor
will start to scroll from left to right from its current position, and new audio events
will be recorded to record-enabled tracks.

Recording will continue until you manually stop it by clicking on the Stop button in
the Transport or by pressing [Spacebar] on the keyboard.

When you press Record, the Session automatically locks. This prevents you from
accidentally stopping recording Session. You must disable Session Lock before you
can stop recording.
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3.5 Importing and Exporting Audio Files
3.5.1 Importing Audio Files into Capture
It is possible to import WAV and AIFF audio files into your Session.

1. To import an audio file, select Import Audio File from the Session menu,
or [Ctrl]/[Cmd]+l on the keyboard, to open the Import File menu.

_ ‘_ Capture File Edit Help

800 Import File... #l
Export Tracks... \ #E
Locate Missing Files...
Start ~
Record *
Lock Record 3L
Stop 0
Return to Zero 3
Locate End E
Loop Active '
Loop Selection
Locate Selection L

Insert Marker
Locate Next Marker N
Locate Previous Marker B

Enable Soundcheck F4

2. Browse to the desired file and click on it to select it.

mport Files
[« v (2= il v | [ = ~ | (& Audio Files =
FAVORITES ion.capture - Acoustic Gtr.wav
3 Dropbox Session.song B - Backing vox.wav
il ion(2).song E - Bass.wav F‘
# Applications » HE -Hammond.wav
[=] Desktop - Hammond(2).wav
% Documents r 5.capture - Kick.wav
© Download © H - Overheads.wav Name - Overheads.wav
nars B - Rhodes.wav kind Waveform audio
] Movies - Snare.wav Size 212 MB
13 Music T Creared 5/27/112:33 PM
S5 E - stereo Girwav Mod ““: :‘s;’:i 2 :: m
[ Pictures B - Tomsway Last opened 127/
& EBi-D - Vocals.wav Sisallilnd
. - Sample rate 44,100
il Acoustic Gtr.wav e ar Cam
SUKRRD Bits per sample 16
| All Readable Documents 3
- Overheads I
44.1 kHz, 16 bit Mono 27.5.2011 14:34:38 FE—
4:00 min > | [ ] G2 I
| . Ean_(el_l I_ Open‘:.\

3. Click on Open to import the file into your Session.

4. An audio event for the imported file will be created and placed on the currently
selected track in your Session, at the current playback-cursor position.

Power User Tip: When browsing for files in the Import File menu, it is possible to listen
to the audio files as you are browsing in the Preview Player. Click the Play button in the
Preview Player to play the currently selected audio file. Click the Stop button to stop
playback. Click the Loop button to loop the playback of the currently selected audio file.

- Overheads |

44.1 kHz, 16 bit Mono 27.5.2011 14:34:38 —
400 min > | B @ I
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3.5.2 Export Audio Files

Location.

Format.

To export audio from your Session in Capture 2, navigate to Session/Export Tracks,
or press [Ctrl]/[Cmd]+E on the keyboard to open the Export to Tracks menu.

| & Capture File Edit EEEOCIN Help

8 06 | Import File... £
Export Tracks... - 8BE
Locate Missing Files=.
Start ~
Record #
Stop 0
Return to Zero i
Locate End E
Loop Active /
Locz;ne Selection L
Insert Marker
Locate Next Marker N
Locate Previous Marker B

In the top section of the Export Tracks menu, select
a location and name for the audio file.

Export Tracks

Location

Basic Filename

Fat Rocker Live after 5

Folder
[Users/Ell-D/Documents/Capture/1602 Demo Session/Export

Click on the Browse button to choose a file location.

Double-click on the filename, type in a new name, and then press Enter to
choose a name for the file. Each file that is exported will begin with the filename

you enter, followed by the name of the track from which it was exported
and the first marker of the marker pair (if applicable). Examples: “French
Quarter Fest 2012 - Kick” or “French Quarter Fest 2012 - Kick - Chorus.”

In the middle section of the Export Tracks menu, select the
format of the mixdown audio file. Choose from WAV or AIFF, and
then choose the desired resolution and sample rate.

Format
Wave File

Resolution: 16 Bit "

Sample Rate: 44.1 kHz x

If you wish to put your audio on a standard audio CD, the format should
be a WAV file with 16-bit resolution and a 44.1 kHz sample rate.

Library Reference Manual
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Options.

The bottom section of the Export Tracks menu has several
options that will affect how files are created:

O Session

Between Each Marker

Between Selected Markers

o Export Session will export the entire range of your Session to the
furthest point in time that any audio event on a track extends.

o Export Between Each Marker will export separate files for
each range between the markers in the Marker Lane.

o Export Between Selected Markers will export audio files between
the ranges of any two selected markers in the Marker Lane.

3.6  Mixing Your Capture Sessions

3.6.1 Exporting Your Final Mix to an Audio File

The most common physical medium on which recordings are published

is the audio CD. In order to put your final mix on an audio CD, the mix file
must be a 16-bit, 44.1 kHz WAV file. Once you have recorded your final mix
to the Auxiliary Stereo track in Capture 2, it is recommended you export
the audio from the Auxiliary Stereo track to an audio file for this purpose.
See Section 3.5.2 for details on Exporting Audio Tracks in Capture 2.

Once the correct audio file for your mix has been exported, you
may use any CD-burning application (including PreSonus Studio
One Professional) to put that mix on a recordable audio CD.

3.6.2 Mixing a Capture 2 Session in Studio One

Many users want to use Capture 2 strictly as a track-recording tool and will
mix and sweeten the recorded tracks later in a DAW. PreSonus has included a
copy of Studio One Artist with your StudioLive for this purpose. All versions of
Studio One can open Capture 2 Session files. All markers, edits, track names,
etc., will be preserved, and no further effort is required. Simply launch Studio
One and open your Capture 2 Session. See Section 4 for more details.

3.6.3 Mixing a Capture 2 Session in a Different Recording Application

For users who wish to mix their Capture 2 Session in a DAW other than Studio
One, there are several ways in which to import your Capture 2 Session.

Save a Capture 2 Session as OpenTL

Many audio-recording programs can open OpenTL (Open Track List) files. An OpenTL
file provides a reference for all of the audio tracks and audio events, with their
corresponding positions, in a Capture 2 Session, so that another audio program can
reconstruct your Session automatically. This makes it possible for you to open your
Capture 2 Session and work as you normally do in your favorite recording application.

To save an OpenTL version of your Session, select Save
Session As in the File menu of Capture 2.

: #® Capture [0 Edit Session Help

800 New Session... 3N
Open Session... #®0
Close Session BW

Save Session
Save Session As...
Revert

Recent Files
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Name the file as usual, and choose OpenTL (*.tl) in the Save As Type selection box.

006 Save

Save As: ﬁ:_Fat Rocker Live after 5 l IEI

Where: | [ 1602 Demo Session |

¥ Capture Session (.capture) |

et [ Cancel ] F—Save-. ]

Click on Save to save your Session as an OpenTL document and confirm the
command by clicking Yes in the confirmation window. This file will be placed
by default in your Session folder and will not overwrite the original Capture 2
Session file. Note that the OpenTL format will not save your markers.

Import Capture 2 Session Audio Files Directly

Some audio-editing applications (such as digital audio workstations, or DAWSs)
do not support the OpenTL format, which makes the options somewhat limited
when importing Sessions created in other programs. In this case, you must
manually import the audio events from your Capture 2 Session into the audio-
editing application, using whatever means possible in that program. Refer to
the documentation of your software for more information on this process.

Note that in some cases, you may have more than one audio event on a given track,
as opposed to a single continuous audio event, or you may have audio events that
do not have the same start position. In either case, it is highly recommended that
you first export the audio for each track before attempting to import into an audio-
editing program, as described in the Export Audio Files portion of this section.

Be sure to select the Export Tracks option in the Export Audio
File menu, as shown, so that the result of the process will be a
single continuous audio file for each track in the Session.

Once you have single, continuous audio files for each track, directly importing
the files into an audio editor is much easier. All that is required to reconstruct
your Capture 2 Session is to align each file at the same start time. For complete
information on exporting tracks from Capture 2, please review Section 3.5.2.
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Action Key Command

File Menu Transport
New Session Cntrl/Cmd+N Toggle Start/Stop Space Bar
Open Session Cntrl/Cmd+0 Start Enter
Close Session Cntrl/Cmd+W Record NumPad *
Save Session Cntrl/Cmd+S Stop NumPad 0
Save Session As Cntrl/Cmd+Shift+S Return to Zero NumPad
Quit Cntrl/Cmd+Q Record Lock Cntrl/Cmd+L
Edit Menu Navigation
Undo Cntrl/Cmd+Z Focus Next Tab
Redo Cntrl/Cmd+Y Focus Previous Shift+Tab
Cut Cntrl/Cmd+X Left Left Arrow
Copy Cntrl/Cmd+C Extend Selection Left Shift+Left Arrow
Paste Cntrl/Cmd+V Extend Selection Left Add Cntrl/Cmd+Shift+Left Arrow
Delete Del Skip Left Cntrl/Cmd-+Left Arrow
Select All Cntrl/Cmd+A Right Right Arrow
Deselect All Cntrl/Cmd+D Extend Selection Right Shift+Right Arrow
Bounce Selection Cntrl/Cmd+B Extend Selection Right Add Cntrl/Cmd-+Shift+Right Arrow
Zoom In Cntrl/Cmd + or E Skip Right Cntrl/Cmd+Right Arrow
Zoom Out Cntrl/Cmd - or W Up Up Arrow
Zoom Full F Extend Selection Up Shift+Up Arrow
Session Menu Extend Selection Up Add Cntrl/Cmd-+Shift+Up Arrow
Import File Command+| Skip Up Cntrl/Cmd+Up Arrow
Export Tracks Command+E Down Down Arrow
Toggle Start/Stop Space Bar Extend Selection Down Shift+Down Arrow
Record NumPad * Extend Selection Down Add Cntrl/Cmd+Shift+Down Arrow
Stop 0 Skip Down Cntrl/Cmd+Down Arrow
Return to Zero , Page Up Page Up
Go to End E Extend Selection Page Up Shift+Page Up
Loop Active / Extend Selection Page Up Chtrl/Cmd-+Shift-+Page Up
Loop Selection P Add
Locate Selection L Skip Page Up Cntrl/Cmd+Page Up
Insert Marker Ins, | Page Down Page Down
Insert Named Marker Shift+Ins, Shift+1 Extend Selection Page Shift+Page Down

Down

Extend Selection Page
Down Add

Cntrl/Cmd-+Shift+Page Down

Skip Page Down

Cntrl/Cmd+Page Down

Start Home
Extend Selection Start Shift+Home
Extend Selection Start Add Cntrl/Cmd+Shift-+Home
Skip Start Cntrl/Cmd+Home
End End
Extend Selection End Shift+End
Extend Selection End Add Cntrl/Cmd+Shift+End
Skip End Cntrl/Cmd+End

Locate Next Marker N

Locate Previous Marker B

Enable Sound Check F4
Tools

Select Arrow Tool 1

Select Range Tool 2

Select Split Tool 3

Select Eraser Tool 4
Views

Options Cntrl/Cmd+[+]

Big Meters F2

Marker List F3

Enable Soundcheck F4
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4 Studio One Artist Quick Start

All PreSonus professional recording products come with Studio One Artist
recording and production software. Whether you are about to record
your first aloum or your fiftieth, Studio One Artist provides you with all

of the tools necessary to capture and mix a great performance.

Power User Tip: As a valued PreSonus customer, you are eligible for a discount
upgrade to Studio One Professional. For more details on the Studio One upgrade
program for PreSonus customers, please visit http://studioone.presonus.com/.

4.1 Installation and Authorization

Once you have installed the drivers for your audio interface and connected it
to your computer, you can use the included PreSonus Studio One Artist music-
production software to begin recording, mixing, and producing your music.
To install Studio One Artist, log into your My PreSonus account and register
your interface. Your product key for Studio One Artist will automatically be
registered to your My PreSonus account with your hardware registration.

Downloading and running the Studio One installer.

To install Studio One Artist, download the Studio One Artist installer from
your My PreSonus account to the computer on which you will use it.

i ibin | © Bt e 0 S - oS Actharions - Mansgs Actwsicn

To install this software...

Dowricad instaber for Mao

Prmeres X1 Gore Aranth: Gutirs Proserce X1 Gors tasses Prsmeress KT (ors Elertric Getars Prsere X1 Gors Keybunts

Fresence Prsareon 5T Gorn Srvegs Porsorvon KT Gors S

35


http://studioone.presonus.com/

4.2

Studio One Artist Quick Start StudioLive™ AR-Series Software

Setting Up Studio One

Authorizing Studio One

Library Reference Manual

¢ Windows users: Launch the Studio One Artist installer

and follow the onscreen instructions.

o Mac users: Drag the Studio One Artist application into

the Applications folder on your Mac hard drive.

When Studio One is launched for the first time on your computer, it will
communicate with your My PreSonus account and verify your registration. To
ensure a seamless authorization process, make sure to download your installer
to the computer on which you will be using it and be sure that your computer is
connected to the Internet when you launch the application for the first time.

Installing bundled content for Studio One Artist.

Studio One Artist comes bundled with an array of demo and tutorial
materials, instruments, loops, and samples. The Studio One Artist
bundle includes all that you need to begin producing music.

The first time you launch Studio One Artist, you will be prompted
to install its companion content. Select the content you wish to
add and click“Install’ The content will automatically begin to
download and install from your My PreSonus user account.

Package Status
4 i Legacy Gontent
@ Studio One Demos and Tutorials 450.00 MB
B Studio One Instruments Val. 1 148.00 MB Installed
% Ueb all Impact Drums 65.00 MB Installed
Studio One Expansion 38.00 MB Installed
Studio One Musicloops 175.00 MB Installed
Studio One Piano 369.00 MB Installed

Vengeance-Sound 839.00 MB Installed

Voodoo One Synth B884.00 MB Installed
Studio One Instruments Vil. 2 1.42 GB Installed
Electronic Audioloops 2.95 GB
Acoustic Drum Kits and Loops 1.44 GB
Studio One Electric Pianos and Organs 1.8 GB

Check for Available Downloads Install

W

Power User Tip: You may be prompted to enter your My PreSonus user account
information. Clicking “Remember Credentials” will allow you to have immediate
access to any content you purchase from the PreSonus Marketplace.

Setting Up Studio One

Studio One Artist was designed to work with PreSonus interfaces and provides
unique interoperability and simplified setup. When Studio One Artist is
launched, by default you will be taken to the Start page. On this page, you will
find document-management and device-configuration controls, as well as a
customizable artist profile, a news feed, and links to demos and tutorials from
PreSonus. If you have an Internet connection on your computer, these links will
be updated as new tutorials become available on the PreSonus Web site.

Complete information on all aspects of Studio One Artist is available in
the Reference Manual PDF located within Studio One. The information
in this tutorial covers only the basic aspects of Studio One Artist and is
intended to get you set up and recording as quickly as possible.
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4.2.1 Configuring Audio Devices

1. In the middle of the Start page, you will see the Setup area. Studio One
Artist automatically scans your system for all available drivers and selects
a driver. By default, it will choose a PreSonus driver if one is available.

StudioLive AR16 USE

192.0 kHz 64 samples

Configure Audio Device

Configure Externa

2. Ifyou do not see your device listed on the Start page when
you launch Studio One, click on the Configure Audio Devices
link in the Setup area to open the Options window.

© B ® %

Locations Audio Satup External Davices Advanced

Audio Device Built-in Output

Built-in Output

StudioLive AR16

el . o

Input Latency 2322 ms /1024 samples
Qutput Latency 11.97 ms 7/ 528 samples
BSample Rate 44.1 kHz

Bit Depth a2

In the Options window, click on the Audio Setup tab and
select your device driver from the pull-down.
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4.2.2 Configuring MIDI Devices

From the External Devices window in Studio One Artist, you can configure
your MIDI keyboard controller, sound modules, and control surfaces. This
section will guide you through setting up your MIDI keyboard controller
and sound modules. Please consult the Reference Manual located within
Studio One for complete setup instructions for other MIDI devices.

If you are using a third-party MIDI interface or USB MIDI-controller
keyboard, you must install any required drivers for these devices before
beginning this section. Please consult the documentation that came
with your MIDI hardware for complete installation instructions.

If you do not have any MIDI devices, please skip to Section 4.4.

Setting up an external MIDI keyboard controller from the Start page.

A MIDI keyboard controller is a hardware device that is generally used for playing
and controlling other MIDI devices, virtual instruments, and software parameters.
In Studio One Artist, these devices are referred to as Keyboards, and they must be
configured before they are available for use. In some cases, your MIDI keyboard
controller is also used as a tone generator. Studio One Artist views the controller
and tone-generation functions as two different devices; a MIDI keyboard controller
and a sound module. The MIDI controls (keyboard, knobs, faders, etc.) will be

set up as a Keyboard. The sound modules will be set up as an Instrument.

You can set up your external MIDI devices from the Setup area
in the Start page. Before setting up a new Song for recording,
take a moment to configure external devices.

Make sure you have connected the MIDI Out of your external MIDI controller to
a MIDI In on your PreSonus audio interface (if available) or other MIDI interface. If
you are using a USB MIDI controller, connect it to your computer and power it on.

1. Click on the Configure External Devices link in the Setup area on
the Start page to launch the External Devices window.

StudioLive AR16 USB

192.0 kHz B4 samples
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2. Click the Add button. This will launch the Add Device window.

o m @ @

Genoral Locations Audio Setup External Devices

Add, . Edit... Remeove Placement... Reconnect..

¥

+" Notify me if devices are unavailable when Studic One starts

Prederences Song Setup

3. From the menu on the left, select your MIDI controller from the list of
manufacturers and models. If you do not see your MIDI controller listed,
select New Keyboard. At this point, you can customize the name of
your keyboard by entering the manufacturer and device names.

Devica Modal New Keyboard
Manufasturar

Devica Name New Keyboard

MIDE Channels Al
1285 678800248

Raceive Fram MIDE Part #1

Fitter Aftertouch
Program Changa
Pitch Band

Controliers

Send To Nong

Spit Channals

| Default Instrument Input

4. You must specify which MIDI channels will be used to communicate with
this keyboard. For most purposes, you should select all MIDI channels.
If you are unsure of which MIDI channels to choose, select all 16.

5. Studio One allows you to filter out specific control functions. If you would
like Studio One to ignore Aftertouch, Pitch Bend, Program Change, or
All CC messages, enable filtering for any or all of these messages.

6. Inthe Receive From drop-down menu, select the MIDI interface
input from which Studio One Artist will receive MIDI data (that
is, the MIDI port to which your keyboard is connected).

Power User Tip: In the Send To drop-down menu, select the MIDI
interface output from which your Studio One Artist will send MIDI data
to your keyboard. If your keyboard controller doesn’t need to receive
MIDI data from Studio One, you can leave this unselected.
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7. Ifthisis the only keyboard that you will use to control your external
synthesizers and virtual instruments, you should check the box
next to Default Instrument Input. This will automatically assign your
keyboard to control all MIDI devices in Studio One Artist.

8. Click OK.

If you have a sound module that youd like to connect, leave the External
Devices window open and proceed to the next part of this section.
If not, you can close the window and skip to the next section.

Setting up an external MIDI sound module from the Start page.

MIDI instrument controllers (keyboards, MIDI guitars, etc.) send musical information
in the form of MIDI data to tone modules and virtual instruments, which respond
by generating sound, as instructed. Tone modules can be standalone sound devices
or can be integrated into a MIDI instrument, such as a keyboard synthesizer. Studio
One Artist refers to all tone generators as Instruments. Once you have set up your
MIDI keyboard controller, take a moment to configure your sound module.

Make sure you have connected the MIDI In of your external
sound module to the MIDI Out of your MIDI interface.

1. In the External Devices window, click the Add button.
General I.ncali;l- Audio Setup External Devices

Name Send To Raceive From Ck T In

Add. . Edit... Ramaove Placement... Reconnect...

¥

~ Notify me if devices are unavailable when Studic One stars

Pretarances Bong Setup
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2. Select your device in the menu on the left. If your device is not listed,
select New Instrument. At this point you can customize the name of
your keyboard by entering the manufacturer and device names.

Device Model New Instrument

Manufacturer

Davice Name New Instrumant

Recsive From

Send To MIDI Part #1

MIDI Channels All |
T2 3 4 6586 7 8 08 10111293 1415 18

Sand MIDI Timacode

CC Automation Interval  10ms |

3. Specify which MIDI channels will be used to communicate with this sound
module. For most purposes, you should select all MIDI channels. If you are
unsure of which MIDI channels to select, we suggest you select all 16.

4. Inthe Send To menu, select the MIDI interface output from which Studio One
Artist will send MIDI data to your sound module. Click OK and close the External
Devices window. You are now ready to start recording in Studio One Artist.

The rest of this Quick Start Guide will go over how to set
up a Song and will discuss some general workflow tips for
navigating through the Studio One Artist environment.

4.3 Creating a New Song

Now that you've configured your audio and MIDI devices, let’s create
a new Song. We'll start by setting up your default audio I/0.

1. From the Start page, select Create a New Song.

Create a new Song
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2. Inthe New Song window, name your Song and choose the directory in which
youd like it saved. From the Interfaces tab, you can select custom templates for
your StudioLive AR-series mixer that will set all configuration and 1/O settings for
you. The rest of section will describe creating a Song from an empty session.

Btyles Intarfncas. User
My First Sang

Emoty Song
‘f Create an empty song { ih/Documents/Studiolna.onge .

Sample Rate 44.1 kHz
Resolution 24 Bit
Gars
Length 500 i
Temps 120.00 BPM

Time Signature

' Stretch audio files 1o Son;

Empty Sang

Craats an ampty song

3. Select Empty Song from the Templates list. At this point, you should give
your Song a name and select your preferred sample rate and bit depth for
recording and playback. You can also set the length of your Song and the
type of time format you would like the timeline to follow (notation bars,
seconds, samples, or frames). Click the OK button when you are finished.

Power User Tip: If you plan to import loops into your Song, make
sure that the Stretch Audio Files to Song Tempo option is selected.
This will automatically import loops at the correct BPM.

Configuring Your I/0

1. Click on Song | Song Setup to set your sample rate and
resolution and configure your audio I/0.

Studio One File Edit BLLLE Track Evar_l_t Audio Tra|

Import File... 0%0
Export Mixdown... ¥E
Export Stems... T 3#E

Update Mastering File...
Add to Project >

Locate Missing Files...
Locate Missing Devices...
Remove Unused Files
Copy External Files...

Show Media Folder in Finder

Song Setup...

Song Information \

2. Click on the Audio I/0 Setup tab.

» @~

Audio 1/0 Setup
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3. From the Inputs tab, you can enable any or all of the inputs on your StudioLive
AR mixer that you'd like to have available. We recommend that you create a mono
input for each of the inputs on your interface. If you plan on recording in stereo,
you should also create a few stereo inputs. You can give each input a custom name
by simply clicking on the default name. Press the TAB key to edit the next name.

© B e

Genoral Mata Informaton  Audio 110 Setup

Add Mono]  Add [Stereci  Remowe  Make Dafaul

Prefersnoss Sang Selup

4. Click on the Outputs tabs to enable any or all of the outputs on your StudioLive
AR Mixer. In the lower right corner, you will see the Audition select menu. This
allows you to choose the output from which you will audition audio files prior
to importing them into Studio One Artist. In general, you will want this to
be the main output bus. You can give each output a custom name by simply
clicking on the default name. Press the TAB key to edit the next name.

© B e

Genernd Mota Information  Audia WO Setup

Dutputs

Sispar Channal

Channsl 18190

Add (Mona)l  Acd Bterec)  Remove  Make Datast  Audtion

Pratamnces Hong Setup

Power User Tip: If you would like this I/O configuration to be the same
every time you open Studio One, click the Make Default button.
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4.3.2 Creating Audio and MIDI Tracks

1. In the upper left corner of the Arrange window, you will notice
several buttons. The button furthest to the right is the Add Tracks
button. Click on this button to open the Add Tracks window.

@006

2. Inthe Add Tracks window, you can customize the track name and
color, add a preset rack of effects, and set the physical source for
the input and output of your audio tracks. Most important, you can
select the number and type of tracks youd like to create.

Add Tracks

Audiol
4 Pack Folder
Audio

Auto-Color

Format Mong
Preset Mo Preset
Input Mone Ascending

Output Main Ascending

Cancel OK

hil

e Audio. Use this track type to record and playback audio files.

e Instrument. Use this track to record and playback MIDI data to
control external MIDI devices or Virtual Instrument plug-ins.

o Automation. This track type lets you create automated
parameter controls for your session.

» Folder. This track helps you to manage your session as
well as to quickly edit multiple tracks at once.

Power User Tip: If you would like to add an audio track for each of the
available inputs, simply go to Track | Add Tracks for All Inputs.

Rec Track
Mute Arm Name

Solo | Monitor
Custom

Track 1 M [Ele [l Avdio 1

ST/Mono O Inputi -

None
Input 1 - Front Left
Input 2 - Front Right

Audio Input
Source Select

Audio 1/O Setup

Note: MIDI tracks are nearly identical to Audio tracks. The Input
Source list for MIDI tracks lists available external MIDI devices as well
as any virtual instruments that have been added to the Song.
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4.3.3 Recording an Audio Track

To begin recording, create an audio track from the Add Tracks
window, set its input to Input 1 on your StudioLive AR-series
mixer, and connect a microphone to the same input.

Name m
Type Audio -
Count 1 Pack Folder

Color v Auto-Color

Format
Preset Mo Preset
Input Input 1 Ascending

Oulput Main Ascending

Cancel 0K

hil

Select Record Enable on the track. Turn up the Input 1 level on your audio
interface while speaking/singing into the microphone. You should see
the input meter in Studio One Artist react to the input. Adjust the gain

so the input level is near its maximum without clipping (distorting).

1 M s e @ Audol

Input 1 v O

You are now ready to start recording. For complete instructions, please consult the
Studio One Reference manual located in Help | Studio One Reference Manual.

4.3.4 Adding Virtual Instruments and Effects

Opening the browser.

You can add plug-ins and instruments to your Song by dragging-and-dropping
them from the browser. You can also drag an effect or group of effects from one
channel to another, drag in customized effects chains, and instantly load your
favorite virtual-instrument preset without ever scrolling through a menu.

In the lower right corner of the Arrange window are three buttons:

Mix Browse

o The Edit button opens and closes the audio and MIDI editors.
o The Mix button opens and closes the Mixer window.

o The Browse button opens the browser, which displays all of the
available virtual instruments, plug-in effects, audio files, and MIDI files,
as well as the pool of audio files loaded into the current session.
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Drag-and-drop virtual instruments.

To add a virtual instrument to you session, open the browser and click on
the Instrument button. Select the instrument or one of its patches from the
instrument browser and drag it into the Arrange view. Studio One Artist will
automatically create a new track and load the instrument as the input.

4 {5 Pr
3 w m
3 w ai T
4 W Maijito

default

Insert Instrument on new Instrument Track|
Molito: Basslead

Drag-and-drop effects.

To add a plug-in effect to a track, click the Effects button in the browser and
select the plug-in or one of its presets in the effects browser. Drag-and-drop
the selection over the track to which you would like to add the effect.

Bars + Adaptive
Timebase Snap

» FX Flanger

b FX te

Add FX on Channel "Audio!":
Groove Delay: Clean Filters

4 + Filtered Bth
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Drag-and-drop audio and MIDI files.

Audio and MIDI files can be quickly located, auditioned, and imported into
your Song by dragging them from the file browser into the Arrange view.
If you drag the file to an empty space, a new track will be created with

that file placed at the position to which you dragged it. If you drag the file
to an existing track, the file will be placed as a new part of the track.

struments Effects | Loops = Files Pool O

Style v Instrument Character

100bpm A

¥
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Dinner is Served

Added bonus: PreSonus’ previously Top Secret recipe for. ..
Redfish Couvillion

Ingredients:

o 4 CVegetable oil

o Y4 Cflour

» 1 onion diced

* 1 clove garlic minced
» 1 green pepper diced
o 3celery stalks diced

o 1140z can diced tomatoes
o 1 bottle light beer

o 2bay leaves

e 1tspthyme

o 2 lbs Redfish fillets

Cooking Instructions:

1. Inaheavy saucepan or large skillet, heat oil on medium high and slowly add flour a tablespoon at a time to create a roux.
Continue cooking the roux until it begins to brown, creating a dark blond roux.

Add garlic, onions, green pepper, and celery to roux.

Sauté vegetables for 3-5 minutes until they start to soften.

Add tomatoes, bay leaves, thyme, and redfish. Cook for several minutes.
Slowly add beer and bring to a low boil.

[

Reduce heat and simmer uncovered for 30-45 minutes until redfish and vegetables are completely cooked, stirring
occasionally. Break up redfish into bite size chunks and stir in. Add pepper or hot sauce to taste. Do not cover.

7. Serve over rice

Serves 6-8

While not one of Southeast Louisiana’s more famous dishes, Redfish Couvillion is a favorite way to serve our
favorite Gulf fish. Also known as Reds or Red Drum, Redfish is not only fun to catch, it's also delicious!

2017 PreSonus Audio Electronics, Inc. All Rights Reserved. StudioLive and PreSonus are trademarks or registered trademarks of PreSonus Audio Electronics, Inc. Capture, Impact,
Mixverb, Presence, RedLightDist, SampleOne, Studio One, and Tricomp are trademarks or registered trademarks of PreSonus Software Ltd. Mac and macOS are registered trademarks
of Apple, Inc., in the U.S. and other countries. Windows is a registered trademark of Microsoft, Inc., in the U.S. and other countries. Other product names mentioned herein may be
trademarks of their respective companies. All specifications subject to change without notice...except the recipe, which is a classic.
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